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INTRODUCTION
Typically, large organizations face a wide range of challenges, such as finding the most efficient deployment
method, and properly configuring an application for use in networked, multi-user settings. With this in mind,
we’ve presented guidelines in the following pages for planning and implementing your Bluebeam Revu
deployment.
It’s important to note that this guide is written under the assumption that the reader understands the
fundamentals of concepts such as software installation, the Windows Command Line, as well as writing and
running batch files.
Note: You can find guidelines for post-installation management of your deployment in the Bluebeam
Revu Enterprise Administration Guide.
If you’re looking for information about using Revu in your Citrix environment, please refer to “Bluebeam
Revu in a Citrix Environment,” which can also be found on the Bluebeam Technical Services website.
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PLANNING YOUR DEPLOYMENT
The importance of properly planning your deployment can never be overstated, so to help ensure that
everything goes smoothly let’s take a look at some details that must be considered before you start running
your installations.

Compatibility & System Requirements

The last thing you want is to do is attempt to install and run an incompatible combination of hardware and
software in your environment. To prevent this, please make sure you’re familiar with the following
recommendations and requirements in this section before going any further.

Supported Operating Systems


Windows 10 (32-bit and 64-bit)



Windows 8.1 (32-bit and 64-bit)



Windows 7 Service Pack 1 (32-bit and 64-bit)

Microsoft Windows Installer and .Net Framework


Windows Installer 4.5 and above.



.NET Framework 4.5.2 and above.

Windows Installer and .Net Framework requirements for older Revu version can be found on our website.

Recommended Minimum Hardware
A general class computer that meets the following requirements may be used with Revu for general office
tasks:


Processor:
For desktops and laptops: 1 GHz processor or equivalent.
For tablets: Intel i3 processor or equivalent.



RAM:
4 GB on a 32-bit Windows system
8 GB on a 64-bit Windows system



At least 4 GB of available hard drive space



Display: 1024 x 768 high color, 32-bit

If your end-users will be working with large PDF drawing sets, or running the Optical Character Recognition
(OCR) feature, you should make sure their systems meet or exceed the following requirements:


Processor:
Intel i5 Dual Core or better



RAM:
8 GB on a 64-bit Windows system

The latest compatibility information can be found on our website.
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Gathering Your Resources
Assuming your environment meets or exceeds the requirements in the previous section, make sure you have
everything you’ll need before you begin the deployment process. This ensures your implementation is
organized and runs as smoothly as possible. With that in mind, this Installation Guide is the best place to
start.

The Bluebeam Revu Enterprise Administration Guide
The Revu Enterprise Administration Guide covers various post-installation topics such as license
management, Bluebeam Studio, the Bluebeam Administrator application, Revu Preferences and settings, as
well as electronic and digital signatures.
It’s a good idea to read through this and compare the information to your current and anticipated end-user
requirements. Once you’ve done this you’ll know how to plan for and provided them with the various
options they need, such as digital signatures, custom settings, and even custom Tool Sets for use by
multiple users.

The Enterprise Installation Packages
There are two different installation packages available for download from our Enterprise Installation page,
and which one you choose depends on whether or not you’re doing a full installation or updating an
existing installation.
Note: Both installers utilize the Microsoft Windows Installer framework (msiexec.exe), so it’s very important
that the correct Windows Installer version is already installed on your machines.

The MSI Installer
This is the file you’ll use for deploying a full installation of any Revu Edition.
It’s very important that you download the correct Enterprise installation package for your environment.
Once you’ve done that, open the zip file and become familiar with its contents, which are:


A ReadMe file listing the contents of the MSI package and installation pre-requisites.



The Revu MSI installation file




The Microsoft .NET Framework 4.5.2 offline installer
A script for removing older Revu versions. (Uninstall Previous Version.txt – The file extension must be
changed to .bat before it can be run.)



An Add-Remove-Programs (ARP) Modifier, in case you want to display the Edition of your Revu
software, in addition to the product name and version number.

The process for running this installer is covered later on this this guide, and you should carefully follow the
instructions. Please do not take shortcuts or otherwise modify the workflow. Most of all, do not edit the MSI
directly as it will invalidate the digital signature.

The MSP Installer
This installer is used for patch updates from one dot release to another within a major version number. The
advantage of the MSP file is that it doesn’t require any additional configuration because it’s being applied
to an existing installation of the same major version and Edition, using the same license.
Note: Please make sure you take a look at the ReadMe file included in the MSP package.
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Custom Settings and Assets
If your organization uses optional custom or shared settings and assets, such as Preferences, Profiles, Tool
Sets, and Stamps, we suggest working with a point person from each department within your user
community to find out what they are and gather them. The Revu Enterprise Administration Guide contains
information about the best practices for exporting gathering and staging these items. The process for
including them in your deployment is described later in this guide.

Setting Up a Staging Computer
There may be certain situations where you’ll be required to create any required custom settings and assets
of your own. In this instance you’ll need to manually install Revu on a machine that you’ll use for creating
these assets, as described in the Managed Net Configuration section of the Revu Enterprise Administration
Guide.
For this single installation you can download the installer from our Downloads and Updates page.

THE DEPLOYMENT PROCESS
Now that you’ve finished planning your deployment, let’s take a look at the best practices and instructions
for performing your enterprise installation of Revu.

Side-By-Side Installation
Revu 2017 can be installed and run side-by-side with Revu 2016.x and above, which lets your end-users run
Revu 2017 as a fully-functional 30-day trial. This lets users evaluate Revu 2017 while your organization
decides whether or not it’s time to upgrade.
Note: When you do decide to upgrade to Revu 2017 you must remove the older software first by pushing
out the “Uninstall Previous Versions” script included in the Revu 2017 MSI Deployment Package. Otherwise
it can be removed via Programs and Features in the Windows Control Panel.

Best Practices
Microsoft Windows Installer

Regardless of which installation package or deployment vehicle you use, your Command Line script will call
up the Windows Installer (msiexec.exe.exe) during the course of your installations. With this in mind, there
are various deployment tools which utilize the command line for running an MSI or MSP installer, such as
System Center Configuration Manager (SCCM), Dell KACE, and Group Policy.

Working with the MSI
Although it is possible to directly edit the MSI (or MSP) file and save it, we don’t recommend doing so, as it
will invalidate the files’ digital signature. Also, doing “save-as” may corrupt the file, and renaming it will
cause the installation to fail.
With this mind, the best way to work with the file is to use an MSI editor such as InstEd to create and edit an
MST file, then pass the properties as described in the MST installation steps below.
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Important Notes about Revu Upgrades


If you’re upgrading from Revu 2015.x to Revu 2017, you should not run the “Uninstall Previous
Versions” script included in the Revu 2017 MSI Deployment Package. In this instance the Revu 2017
installer will detect, unregister, and uninstall the older software.



Do not run the “Uninstall Previous Versions” script if you’re going perform Side-by-Side installations.



Side-By-Side installation of Revu 2017 is not supported with Revu 2015.x and below.

Authorization
In order to make sure your software is successfully authorized, your firewall or proxy server must be
configured to allow access to our licensing servers listed below, via HTTPS on port 443.
Authorization Servers
For installations of Revu 2016 and above:
https://login.microsoftonline.com/

Activation Server
For all Revu installations:
https://activation.bluebeam.com

For Revu 2015.5 and 2015.6 installations:
https://bluebeam-useast.accesscontrol.windows.net

Delayed Authorization
Delayed Authorization is the best registration method when using deployment software such as SCCM,
and/or in situations where the System account doesn’t have access to the internet. In this instance, Revu
won’t attempt to communicate with the licensing servers until the end-user opens Revu post-installation,
and tries to save a document. The registration process runs “silently” in the background as long as the
correct licensing information was used and the machine successfully connects to the internet.
To enable Delayed Authorization you will need to use the DA property found in the MSI Properties Table.
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The MSI Properties Table
In addition to specifying the required Revu Serial Number, Product Key, and Edition used for authorizing
your installations, this list of editable parameters includes optional items which let you customize your
software.

Mandatory Properties

As implied above, these properties are required to successfully authorize the software.
The Serial Number and Product Key will only work with the version and Edition listed on your License
Certificate. If you’ve lost your License Certificate, please contact us to request another copy.
BB_SERIALNUMBER

Enter the Revu Serial Number. Enter TRIAL to install as a 30-day trial.

BB_PRODUCTKEY

Enter the Revu Product Key. All upper-case characters.

BB_EDITION

Standard = 0 CAD = 1 eXtreme = 2 (default)

Supported Optional Properties
BB_ANALYTICS

Send usage info to Bluebeam (default) = 1, Don’t send = 0 (See notes.)

BB_DEFAULTVIEWER

Set as the default application (default) = 1, Do not change the default = 0
(See notes.)

BB_DESKSHORTCUT

Revu desktop shortcut (default) = 1, No short cut = 0

BB_DESKSTAPLER

Bluebeam Stapler desktop short cut = 1, No Shortcut (default) = 0

BB_FEATURES

Disables various Revu features. All Features Enabled = 65535 (default).
See Enabling and Disabling Revu Features with BB_FEATURES for more
information.

BB_IE_PLUGIN

Install and enable = 1, Disable (default) = 0

BB_JOBOPTIONS

Enter the UNC or fully-qualified path to your custom .jobOptions file.

BB_NETCONFIG

Enter the UNC or fully-qualified path to your managed NetConfig folder.

BB_NEW_INSTALL_PATH

Enter the fully-qualified path.

BB_PAGESIZE

Enter "A4" to override default page size for the Bluebeam PDF printer.

BB_QUICKLAUNCH

Enable Quick Launch = 1, Disable (default) = 0

BB_REDICON

Red Revu file icon = 1, Blue (default) icon = 0

BB_REVUPREFERENCES

Enter the UNC or fully-qualified path to your RevuPreferences.xml file.

DA

Delayed Authorization = 1, Standard Authorization (default) = 0

IGNORE_RBT

Disable Check for Pending Reboot = 1, Check for Pending Reboot = 0.
(See notes below.)

MBCODE

Determines which of the Bluebeam plugins are enabled. The default value
of 1023 enables all of them. See Enabling the Bluebeam Plugins with
MBCODE for more information
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The BB_ANALYTICS Property
By default, Revu is set to send usage data to us in order help improve the application. This information is
anonymous and will not be shared with 3rd parties. Bluebeam will not collect personal information about
you. The data tracking we have implemented helps us understand which Revu functions and features you
are using, and how well the application is performing
If you want to disable this, you must deploy your installations with the BB_ANALYTICS Property set to Zero
(BB_ANALYTICS=0) in your MSI command line script or MST file.
Setting the Default PDF Program with BB_DEFAULTVIEWER
Microsoft has changed how default applications are selected in Windows 8 and above, which result in the
BB_DEFAULTVIEWER setting being overridden. This means that your users will have to follow the steps
found in our FAQ article on setting Revu as the default PDF program. Further information can be found on
the Microsoft website.
Enabling and Disabling Revu Features with BB_FEATURES
The first thing to know is that each Revu feature has an assigned numerical value as shown on the list below.
To disable a feature, subtract its numerical value from the default value shown in the preceding table (65535)
and enter the answer as the value for BB_FEATURES property. For example, to disable the Redaction
feature in a Revu eXtreme deployment, you would subtract the value of that feature (2) from 65535, and then
enter the balance (65533) as the value for BB_FEATURES.
To disable multiple features, add their values together, subtract the total from 65535, then enter the
remainder as the BB_FEATURES value.
Revu Features and Their Numeric Values:
Administrator Button (Help Menu) = 128

Product Updates Button (Help menu) = 16

AllFeatures = 255

Redaction in eXtreme (Includes Cut Content & Erase
Content in all Editions) = 2

DigitalSignatures = 4

Registration Button (Help Menu) = 256

EditText = 1

SelfSignCertificates = 8

ExportToOffice = 64

TranslateMarkups = 32

Disabling “Check for Pending Reboot”
It’s important to note that this should only be done (IGNORE_RBT = 1) if Microsoft .Net Framework version
4.5.2 or above has already been installed on the end-user’s machine, and that it was restarted after the .Net
installation.
The pending reboot must eventually be carried out at some point after the installation has completed.
Enabling the Bluebeam Plugins with MBCODE
As with the Revu features listed in the preceding table, each of the Bluebeam plugins for supported thirdparty software has an assigned numerical value, as shown in the table below. If you only want to enable a
single plugin, for example the AutoCAD plugin, you would replace the default MBCODE value of 1023 (all
plugins enabled) with the number 2. In cases where you need to enable more than one plugin, you would
add up their numerical values and enter the total as the MBCODE value. Changing the MBCODE value to 0
disables all of the plugins.
Note: Please refer to the Revu Compatibility Chart to ensure that your third-party applications will work with
the plugins in your Revu software.
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Revu Plugins and Their Numeric Values:
All Plugins Disabled = 0

Microsoft Outlook = 128

AutoCAD = 2

ProjectWise = 64

AutoCAD LT (32 & 64-bit) = 4

Revit & Navisworks = 16

Internet Explorer = 32

SketchUp Pro = 256

Microsoft Office = 1

SolidWorks = 8

Language Transforms (TRANSFORMS)
By default, Revu will be installed in the language of the host operating system. However, it is possible to
deploy installations in a different language from what Windows uses, by setting the TRANSFORMS Property
to one of the language codes listed below. Command line examples for an MST and MSI installation can be
found later in this guide.
Revu Language Transform Codes:
Danish = 1030

Italian = 1040

Dutch = 1043

Japanese = 1041

English = 1033

Korean = 1042

Finnish = 1035

Norwegian = 1044

French Standard = 1036

Spanish = 1034

German = 1031

Swedish = 1053

Optional Pre-Installation Check
If you’re unsure about which Revu Editions are already installed in you user community, it may be a good
idea to consider writing a script which queries the following Windows Registry keys. This information comes
in handy in situation where you have to deploy multiple Editions of Revu:

HKLM\SOFTWARE\Bluebeam Software\RevuVersion#


“Edition” – Key Data value shows the current Revu Edition.

HKLM\SOFTWARE\Bluebeam Software\RevuVersion#\Licenses


“Registered” – Key Data value displays the Revu Serial Number
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Deployment Methods
In this section we’ll cover topic such as Windows Installer Switches, how to write scripts for either full
installations using the MSI, or patch updates using the MSP, as well as how to deploy multiple Revu Editions
– or in different languages within your environment.

A Note about Windows Installer Switches

There are three important Windows Installer switches to be aware of when writing a script for MST, MSI, or
MSP installations:


/i – Tells the Windows Installer to call up msiexec.exe to run an installation



/qn – This switch lets you run unattended and silent installations.



TRANSFORMS – Used if you’ve created an MST that needs to be called up. This is done by entering
the folder path to where the MST file is located and the filename of the MST. TRANSFORMS also
lets you install Revu in different languages.

Writing an Installation Script

Let’s take a look at the different methods for deploying your Revu software, each of which utilize the
command line in slightly different ways.

Using a Microsoft Transform (MST) file
This is the preferred method of deploying your installations because:
a. It minimizes typographical errors, as all property/parameter changes are done in the MST file, which
is called up by a short command line script. This means you can double check your changes to the
Properties table before they’re passed on during the installations.
-Andb. It allows you to hide the licensing information from your end-users.
Creating and Editing an MST File
If you haven’t done so already, you’ll need to download and install an MSI editor such as InstEd. Once
you’ve done that, please follow the steps listed below:
1. Launch InstEd, click the File menu, and open the original MSI.
2. Click the Transform menu and select New Transform.
3. When the New Transforms dialog opens, name the MST file then click Save.
Note: The file should not be called "Transforms.mst," and must be saved in the same folder as the
original MSI installer.
4. Click the Tables tab on the left, select Property in the Tables list. At this point it might help to click
the Property column heading to alphabetically sort the Properties list.
5.

Edit the Properties to suit your requirements.
Note: Only edit the properties and parameters listed in this guide.

6. Click the File menu and Save the file.
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Writing Command Line Script that Uses Your MST File
Here are a couple of installation script examples that call up an MST file:

msiexec.exe /i "Bluebeam Revu x64 17.msi" TRANSFORMS=YourMSTFile.mst /qn
A silent German Language Installation:
msiexec.exe /i "Bluebeam Revu x64 17.msi" TRANSFORMS=:1031;MyTransforms.mst
/qn
Note: It’s very important that you test your script in an elevated command prompt on a test machine, before
deploying the installation to ensure that it runs correctly.
Do not double-click the MSI file. Doing so will install Revu with the default Properties values.

Using the MSI Properties Directly
Another method of building your deployment is to write a complete installation script which calls up the
Revu MSI file, and lists all relevant mandatory and optional property changes.
Note: To make sure there aren’t any syntax errors, it’s a good idea to write and proofread your script in a
text editor, and then run it in an elevated command prompt on a test machine, before deploying to your
end-users. Do not double-click the MSI file. Doing so will install Revu without default properties values,
without any customizations.
To get an idea of how this is done, take a look at the following example of a basic installation script written
so that Revu Standard installs silently, with Delayed Authorization:
The Revu Serial Number, Product Key and Edition must be included in all MSI installation scripts, and the
quotation marks must be included in the MSI filename.

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=0 DA=1 /qn
Additional MSI Script Examples
To help give you a better idea of how command line scripts can be written for various installation
requirements and configurations please refer to the following examples:
Basic silent installation of CAD Edition:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=1 /qn
Basic silent German installation of CAD Edition:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=1 TRANSFORMS=:1031 /qn
Basic silent installation specifying A4 as the default page size for the Bluebeam PDF Printer:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=YourRevuEdition BB_PAGESIZE=A4 /qn
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Basic silent installation specifying a centralized NetConfig location for the Bluebeam settings:
Requires a post-installation restart before the BB_NETCONFIG setting takes effect.

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=YourRevuEdition BB_NETCONFIG=u:\bbconfig /qn
Basic silent installation without a desktop shortcut, that doesn’t set Revu the default PDF viewer:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=YourRevuEdition BB_DEFAULTVIEWER=0
BB_DESKSHORTCUT=0 /qn
Basic silent installation specifying the location of the .JobOptions files:
msiexec.exe /i "\\MyServer\Bluebeam Deployment\Bluebeam Revu x64 17.msi"
BB_SERIALNUMBER=1234567 BB_PRODUCTKEY=YourRevuProdKey
BB_EDITION=YourRevuEdition
BB_JOBOPTIONS=\\MyServer\Bluebeam?Deployment\joboptions /qn
Basic silent installation that also deploys a specific RevuPreferences.xml file:

msiexec.exe /i "\\MyServer\Bluebeam?Deployment\Bluebeam Revu x64 17.msi"
BB_SERIALNUMBER=1234567 BB_PRODUCTKEY=YourRevuProdKey
BB_EDITION=YourRevuEdition
BB_REVUPREFERENCES=\\MyServer\Bluebeam?Deployment\RevuPreferences.xml /qn
Basic silent German installation that also deploys a specific RevuPreferences.xml file:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=YourRevuEdition TRANSFORMS=:1031
BB_REVUPREFERENCES=RevuPreferences.xml /qn
Basic silent installation which deploys a specific RevuPreferences.xml file, and uses Delayed Authorization:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=YourRevuEdition
BB_REVUPREFERENCES=RevuPreferences.xml DA=1 /qn
Basic silent installation that uses the red Revu PDF file icon:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=YourRevuEdition BB_REDICON=1 /qn
Basic silent Revu CAD installation where the MSI is located in a specific UNC folder path:

msiexec.exe /i "\\BluebeamServer\Software\bb\Bluebeam Revu x64 17.msi"
BB_SERIALNUMBER=1234567 BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=1 /qn
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Basic silent Revu eXtreme installation specifying a centralized NetConfig location for the Bluebeam settings when the
MSI is located in a specific UNC folder path:
Requires a post-installation restart before the BB_NETCONFIG setting takes effect. Please refer to the
NetConfig section of the Bluebeam Revu Enterprise Administration Guide for more information.

msiexec.exe /i "\\MyServer\Bluebeam?Software\Bluebeam Revu x64 17.msi"
BB_SERIALNUMBER=1234567 BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=2
BB_NETCONFIG=\\MyServer\Bluebeam?Software\Netconfig /qn
Basic silent Revu Standard installation with just the Microsoft Office and AutoCAD plugins enabled using the MBCODE
parameter:

msiexec.exe /i "Bluebeam Revu x64 17.msi" BB_SERIALNUMBER=1234567
BB_PRODUCTKEY=YourRevuProdKey BB_EDITION=1 MBCODE=3 /qn

Deploying Multiple Editions of Revu
As the MSI installer includes Revu Standard, CAD, and eXtreme, a single MSI can deploy multiple Editions
within your end-user community by staging a single MSI file in a shared location, which can be called up by
any of the three installation scripts (one for each Revu Edition) that you’ll need to write. Each script must
include the corresponding values for the BB_SERIALNUMBER, BB_PRODUCTKEY, and BB_EDITION
Properties.
Once you’ve written and checked your scripts in an elevated command prompt on a test machine, you can
use Group Policy or a task sequence in your deployment vehicle to determine the Revu Edition they should
be running, and then automatically run the correct deployment script.
An alternative method of confirming the Edition and Serial Number of an existing Revu installation is to
write a script which queries the following Windows Registry keys:

HKLM\SOFTWARE\Bluebeam Software\<RevuVersion#>


“Edition” – Key Data value shows the current Revu Edition.

HKLM\SOFTWARE\Bluebeam Software\<RevuVersion#>\Licenses


“Registered” – Key Data value displays the Revu Serial Number

Updating Existing Installations with an MSP File
As mentioned earlier in this guide, this installation file is used for patch updates from one dot release to
another within a major version number, while using the same licensing information.
When writing your command line script, it’s important to note that REINSTALLMODE=omus and
REINSTALL=ALL are both required parameters, and are case-sensitive. Additional information about
Msiexec.exe command line options can be found on the Microsoft website.
Note: We recommend writing and proofreading your script in a text editor, and then running it in an
elevated command prompt on a test machine, before deploying the update to your end-users.
To deploy a basic patch update you’ll need to use the following format:
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msiexec.exe /p <path to .msp> REINSTALLMODE=omus REINSTALL=ALL
Additional MSP Script Examples
Basic silent update:
Msiexec.exe /p <path to .msp> REINSTALLMODE=omus REINSTALL=ALL /qn
Basic silent update with a suppressed reboot:
Msiexec.exe /p <path to .msp> REINSTALLMODE=omus REINSTALL=ALL
REBOOT=ReallySuppress /qn
Silently updating an installation that was deployed with modified Properties:
When patching an installation that was originally deployed with modified Properties, you’ll need to include
them in your MSP script. Not doing so will reset them to their default values.
For example if the installation was set to use the Red PDF file icon with Quick Launch and the Microsoft
Office plugin enabled, the script will be:
Msiexec.exe /p <path to .msp> REINSTALLMODE=omus REINSTALL=ALL BB_REDICON=1
BB_QUICKLAUNCH=1 MBCODE=1 /qn

Running and Troubleshooting a Deployment
Assuming you have written your script, tried it out in an elevated command prompt on a test machine, and
now you can run it in a deployment vehicle of your choice, such as SCCM, Dell KACE, or Group Policy.
If the installations do not go as intended, or otherwise fail, you’ll need to go back and check your work. If
your script is calling up and MST file, reopen it with InstEd and make sure you’ve correctly set the Properties.
After that confirm that you’ve used the correct syntax in the script you have written which calls up the MST
file, and test again in an elevated command prompt on a test machine.
In the case of an MSI or MSP script, check the syntax again to make sure it’s formatted correctly, and that
you’ve included the relevant Properties with the correct settings. Once you’ve done that, you should run it
on your test machine as described earlier.
Note: The MSI installer creates a verbose log file in %TEMP% directory on the local drive of the machine on
which Revu is installed. The naming convention is "MSIxxxxx.log" where "xxxxx" are random characters,
like "MSIjfb1d6.log". Review this log for common Windows installation errors.
If you’re using SCCM the log file can be found in C:\windows\temp when installed via the SYSTEM account
A list of Windows Installer error codes and their definitions on the Microsoft website.
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POST-INSTALLATION: OPTIONAL CUSTOMIZATION DEPLOYMENT
There are two Bluebeam “system” files containing application settings which can be deployed. The
RevuPreferences.xml file which can be deployed at any time, and the UserPreferences.xml which can only be
deployed once a new Revu installation has been finished.

RevuPreferences.xml
This file contains all settings configured in the Revu Preferences dialog (Ctrl+K). Clicking Export in the dialog
window lets you save the RevuPreferences.xml file to any location, such as a centralized folder on a server.
Although it can be deployed as part of an MST or MSI installation you can also do so post-installation using
a command line options that call up the Bluebeam Administrator. This allows you to automate changes
within the Bluebeam Administrator, such as Revu Preferences, product registration, amongst many others.
The following script uses the /PREFSPATH:<path> to deploy the RevuPreferences.xml file:
"%ProgramFiles%\Bluebeam Software\Bluebeam Revu\<RevuVersion>\Pushbutton
PDF\PbMngr5.exe" /setup
/PREFSPATH:<DriveLetter:\FolderPath\to\RevuPreferences.xml>
Note: You can also disable the message asking if Revu should be the default PDF viewer by adding
the /DVOFF switch. Launch the Bluebeam Administrator and click Help > Command Line Options for
more information and a list of additional command line options.
You can also copy or push the RevuPreferences.xml file to:
C:\ProgramData\Bluebeam Software\Bluebeam Revu\<RevuVersion>\Revu
Note: When Revu launches it will search for the RevuPreferences.xml. When it finds that it’s newer than the
UserPreferences.xml file in the user’s %appdata% folder, it will merge the contents into the existing
UserPreferences.xml. You will have to make some form of change to the RevuPreferecnes.xml file to affect
the Modified Date, even if you just open it and add a space at the very beginning of the text.

Merging Revu Preferences

If you only want to add new settings while retaining certain pre-existing settings on the destination machine,
you should first open the RevuPreferences.xml file in a text editor and add Merge=”True” to the beginning
of the file, before staging it for deployment. When the file is found the new settings will be merged into the
contents of the existing UserPreferences.xml. Refer to the Revu Enterprise Administration Guide for more
information.

Editing the RevuPreferences.xml File
As mentioned above you need to edit the RevuPreferences.xml file in order merge its contents into the
existing User Preferences (UserPreferences.xml).
To do this, you’ll need to open the RevuPreferences.xml file in a text editor and type Merge=”True” (case
sensitive) into the header. You can find an example a of an edited RevuPreferences.xml file this later in this
section but here’s what the header should look like:
<RevuPreferenceDictionary Version="1" Merge="True">
After you have done this we recommend that you delete all the other settings that you do not want to
change.
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Example of an Edited RevuPreferences.xml File
The following set of Revu Preferences provides a Revu installation with the URL for an organization’s
Bluebeam Studio Enterprise server and merges these settings into an existing UserPreference.xml file:
<?xml version="1.0" encoding="utf-8"?>
<RevuPreferenceDictionary Version="1" Merge="True">
<Studio>
<Force.Proxy>False</Force.Proxy>
<ServerCache>{"active":
{"RequestedAuthMode":0,"ServerEmail":null,"ServerPassword":"","Serve
rURL":"Studio.CompanyXYZ.com","ServerUserName":""},"servers":
[{"RequestedAuthMode":0,"ServerEmail":null,"ServerPassword":"","Serv
erURL":"Studio.CompanyXYZ.com","ServerUserName":""}]}</ServerCache>
<Toolbar.Integration.Only>True</Toolbar.Integration.Only>
<URL>Studio.CompanyXYZ.com</URL>
</Studio>
</RevuPreferenceDictionary>

UserPreferences.xml
This file contains settings for an individual Revu user. Although this file cannot be deployed to existing
installations, it can be deployed to a new one, prior to their initial launch, by pushing a modified
UserPreferences.xml to the following location on each machine:
C:\Program Files\Common Files\Bluebeam Software\Bluebeam
Revu\RevuVersion#\Revu
Note: Assuming you have already gathered your custom assets such as Profiles and Tool Sets during the
planning phase while planning your deployment, you can also copy them into this location.
The first time Revu is launched, the files are automatically copied to the following location in their roaming
Windows User Profile:
%APPDATA%\Roaming\Bluebeam Software\<RevuVersion#>\Revu
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Deploying Custom Assets & Settings via the Revu.exe Command Line
Another method for deploying custom settings and assets (Profiles, a Shared Profile Directory, or Tool Sets)
is to write a Revu.exe command line script which can be run from a batch (.bat) file. The following sample
script imports a Revu Profile:
"C:\Program Files\Bluebeam Software\Bluebeam Revu\RevuVersion#\Revu\Revu.exe"
/s /bpximport:[File]"

It’s important to note that these are user specific settings which only apply to the current user that is running
the command line. Therefore the script should run as part of a logon script and not as the Administrator.

Revu.exe Command Line Switches
The following switches allow you to select how the import process runs, as wells as which assets you want to
copied into a user’s default local %appdata% Revu roaming folder:
Note: Importing assets or settings copies as described above, whereas “Adding” them creates a reference
(link) to a shared asset located in a network or other non-default location.


/s – You’ll notice this switch in the example shown above, which turns off any prompts that would
usually appear during the import process.



/bpximport:[File] – Imports and activates a profile.



/bpxdir:[Path] – Lets you specify a folder path if you want to designate a new profile directory.
This is the path to a network shared location where Profiles are located and shared across an
organization.
Note: To prevent users from making changes to the Profiles in this directory set its Folder
Permissions to “Read Only.”



/bpxactive:[Name] – Designates a specific Profile as Active in either the users local %appdata%
Revu roaming folder, or in a shared Profile directly if you have used /bpxdir: to specify a shared
Profile directory in a network location. Make sure the Profile you set as Active is in the specified
directory.
Note: Setting a Profile as Active suppresses the initial "Select a Revu Profile" and “Studio Sign-in”
dialogs that appear the first time a new Revu installation is opened.



/btxadd:[File] – This tells a Revu installation to use a Tool Set located in a non-default location
without importing it.



/btximport:[File] – Imports a Tool Set into the current profile directory.



/bhxadd:[File] – Tells Revu to use a Hatch Pattern set located in a non-default location without
importing it.



/bhximport:[File] – Imports a Hatch Pattern set into the current profile directory.



/blxadd:[File] – Tells Revu to use a Line Style located in a non-default location without
importing it.



/blximport:[File] – Imports a Line Style set into the current profile directory.
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Usage Example
The following script silently imports the Power Profile, as well as the “toolset1.btx” and dimensions.btx files,
into that profile:
"C:\Program Files\Bluebeam Software\Bluebeam Revu\RevuVersion#\Revu\Revu.exe"

/s /bpximport:"U:\netProfiles\Power.bpx"
/bpxactive:Power/btximport:"U:\netProfiles\Revu\toolset1.btx"
/btximport:"U:\netProfiles\Revu\dimensions.btx"
Note: When creating and exporting custom Profiles, it best to include any dependencies such as custom
Tool Sets, Hatch Patterns, Line Styles, Custom Columns, or Custom Statuses. Embedding them into the
Profile in this manner makes it a lot easier to share these custom resources across an organization.

ARP Modifier

As mentioned earlier in this guide the MSI Installation package includes an Add-Remove-Programs (ARP)
Modifier, in case you want to display the Edition of your Revu software, in addition to the product name and
version number.
Note: ARP renaming is determined by the BB_EDITION flag that was set during installation process, and not
the Serial Number. You can find further information in the ReadMe file included in the MSI Installation
Package.
Default is to run the file without an Edition parameter.
Example:
ARP_Modifier_currentversion.exe
Optional command line arguments let you customize the behavior of this utility.
Examples:
Forces product name to include “Standard”:
ARP_Modifier_currentversion.exe 0
ARP_Modifier_currentversion.exe standard
Forces product name to include “CAD”:
ARP_Modifier_currentversion.exe 1
ARP_Modifier_currentversion.exe cad
Forces product name to include “eXtreme”:
ARP_Modifier_currentversion.exe 2
ARP_Modifier_currentversion.exe extreme
Restore the product name without the edition (Standard, CAD or eXtreme):
ARP_Modifier_currentversion.exe -1
ARP_Modifier_currentversion.exe clear
Calls up the file from a script where the ARP Modifier is located in a network, and sets the installed Edition as eXtreme:
"\\MyServer\Bluebeam Software\ARP_Modifier_currentversion.exe" 2
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